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Introduction 

IAI is a statutory body established under The Actuaries Act 2006 (35 of 2006) for 

regulation of profession of Actuaries in India. The provisions of the said Act have come 

into force from 10thday of November 2006, in terms of the notification dated 8th 

November 2006, issued by the Government of India in the Ministry of Finance, 

Department of Economic Affairs. As a consequence of this, the erstwhile Actuarial 

Society of India was dissolved and all the Assets and Liabilities of the Actuarial Society 

of India were transferred to, and vested in, the Institute of Actuaries of India 

constituted under Section 3 of the Actuaries Act, 2006. 

The student guide aims to provide all necessary information to appear for upcoming 

actuarial home based online examination. It covers all the points required for pre-

exam preparations, on the exam day and post examination. 

 

Examination Time Table and Announcement 

 
Click here to view Timetable of Actuarial Examination 

Click here to view Announcement of Actuarial Examination 

 

Pre-Exam Preparations 
 

Communication with IAI 

 

- You will be given access to the exam platform 

 

- You are advised to use registered email id and contact number - throughout 

the examination process. 

 

- You will receive exam link and other exam related information’s 2 days before 

the Examination. 

 

- All information related to Actuarial Home Based Online Examination is available 

in Frequently Asked Questions (Annexure A). 

 

- You are advised to email your queries for assistance at 

exam@actuariesindia.org.  

 

 

 

 

 

 

 

http://www.actuariesindia.org/guidance/scanned%20GN.pdf
http://www.actuariesindia.org/downloads/asi_rules.pdf
http://www.actuariesindia.org/downloads/asi_rules.pdf
http://www.actuariesindia.org/downloads/TimetableMarch2022ActuarialExamination.pdf
http://www.actuariesindia.org/downloads/Announcement%20for%20March%202022%20Actuarial%20Exam%20Registration.pdf
mailto:exam@actuariesindia.org
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Technical Requirements 
 

You must meet all the following software and hardware requirements: 
 

Hardware 

Personal Desktop/ Laptop1 

Web Camera 

Microphone 

Operating System 

Licensed Windows 7 and above 

(NOTE: IOS / MAC BOOK ARE NOT ALLOWED) 

.NET Framework 4.5.1 and above 

Web Browser 

(Any One) 

Google Chrome – Ver. 63 and above (Recommended) 

Firefox -Ver. 52 and above (Recommended) 

Internet Minimum speed of 512 Kbps, preferred 1 Mbps and 

above 

Note: Use of mobile hotspot may lead to unstable internet 

connectivity. 

RAM Minimum 512 Mb, preferred 1-2 GB 

Note: Device should have free space of more than 65MB on the default hard drive 
 

For the following subjects, applicants shall also fulfil the additional requirements as 

given below: 

 CM1, CM2, CP2:  

a. MS Office (Licensed) -  2010 or above  
Note: To preserve the integrity and security of the examination process and content. 

Functional Keys, Escape key and right click of the mouse will be disabled during the 

time of examination. Refer FAQ Question 53. 

 

 CS1, CS2:  

a. MS Office (Licensed) -  2010 or above 

b. R version 3.6.1 or higher 

c. R Studio – Version 1.1 or higher for 32 bit operating system 

          Version 1.2 or higher for 64 bit operating system 

d. Packages – base, stats, utils, graphics, fpp, markov chain, forecast, dplyr, 

readxl, psych, corrplot, flexsurv, survival, etc.  
 
Note: Any modifications in above technical requirements will be notified by the Institute. 

System check (Click Here for Demo Video) 

 

- You are strongly advised to check hardware and software of your system way 

ahead of mock and final examination.  

                                                           
1 No tablet or mobile devices are eligible 

https://drive.google.com/file/d/1szYOLpKOdBB2S90IXMD5mF7WGzuSfdRA/view?usp=sharing
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- You are strongly advised to uninstall all Screen Sharing & Antivirus Applications 

and disable the Windows firewall in your system as they may interfere in proper 

functioning of exam secure browser 

- You will receive a link for examination 2 days before the actual examination to 

check system compatibility for home based online examination.  

- Ensure to take necessary steps for the challenges highlighted during mock exam 

way before the final Examination. 

 

Exam Instructions 

- You can use scientific calculator as per IAI approved list during the examination. 

- You can use only hard copy of Actuarial table during the examination. (Note: Print 

or xerox copy is not allowed) 

- You may be asked to provide a 360-degree view of the exam surroundings by the 

proctor/invigilator during the examination. 

- Any malpractices noticed/violation of instructions by proctor/invigilator shall lead 

to termination of your examination. 

- It is brought to your notice that in accordance with provisions contained in the 

Professional Conduct Standard, if any candidate is found copying or involved in 

any other form of malpractice, during or in connection with the examination, then 

he/she will be liable to disqualification from the examination and disciplinary 

action. 

- Any candidate who appears or register the examinations from the excluded 

country as per the Registration Announcement may lead to cancellation of their 

Exam or result of the respective examination. 

- Do not read the questions loudly. 

- Ensure there is enough light on your face and you do not move away from the 

examination screen and ensure that the web camera is not covered/ blocked by 

any object, even your hands while giving the exam as the same shall be treated 

as violation. 

- In case you get disconnected from the examination, please click on the same 

examination link shared with you and you may be able to resume from where you 

had left off after 7-8 minutes. In case you are not able to reconnect within 20 

minutes from the time of disruption, kindly call the technical support as well as 

inform Institute immediately for assistance. 

- All your screen activities will be recorded and captured. Ensure that you do not 

open any application/files other than that mentioned in the question.  

- Don’t use any electronic devices like mobile phones, earphones/headphones, 

tablets, smart watch etc. during the exam it will be treated as violation. 

- You can navigate the questions by navigation panel on top of exam window or 

by clicking “Next” available on bottom right of exam window. 

- You are strongly advised to keep a track of exam timer to avoid loss of time. 

http://www.actuariesindia.org/downloads/Announcement%20for%20March%202022%20Actuarial%20Exam%20Registration.pdf
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Do not press F5 key at any point during the examination. 

 
 

- For text editor based examination do not press Ctrl+Z shortcut key at any point 

during the examination. 

- Kindly navigate the questions appropriately, ensure you do not click on “All 

questions” button available on top right of the exam window. You can also 

navigate using “Prev Question” and “Next Question” buttons available on bottom 

right of exam platform.  

Note: The above is not applicable for CS1, CS2, CM1, CM2 & CP2 Subjects. 

- The examination will terminate automatically at the exam end time. 

- For CS1, CS2, CM1, CM2 & CP2 Subjects, you are strongly advised to keep saving 

your answerscripts on your local drive and upload the same on examination 

platform in a timely manner. It is advisable that the students utilise the last 15 

minutes of the examination duration for uploading the answer script in the 

platform to avoid last minutes hassles. The last successfully uploaded answerscript 

in exam platform shall be considered for evaluation. 

Note: AutoSaved feature is not applicable to above subjects. 

- Finish Test button will be available at the top right corner and only click on it once 

you have answered all questions.  

 

On the Day of Examination 
 

You are strongly advised to go through the below do’s and don’ts before sitting for 

online examinations.  
 

Do's Don'ts 

Keep yourself cool and calm Don't panic during the examination 

Keep your exam desk neat and clean. Don't use sticky notes, notepads, etc. 

Keep your Hall Ticket and Government ID 

proof in original handy. 

Don't move away from system during the live 

examination. 

You can keep only approved scientific 

calculator, Actuarial table, blank papers and 

pen with you for rough work 

Don't use any electronic gadget viz. Cell 

Phones, Earphones/Headphones, Smart 

Watch, Fitness Band, etc. 

Keep your mail id logged-in before exam 

start time. 

Don’t access any other browser or social 

accounts during the exam. 

Keep a transparent water bottle. Don’t connect any external ports to system 

during the Examination.  Keep track of exam timer available on the 

upper right corner of the exam window 

during the examination 

Use restroom before login. 
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Do's Don'ts 

To adhere the instructions to the examinees 

available in the hall ticket and the 

instructions of the proctor/invigilator 

throughout the examination. 

Don’t violate the instructions to the 

examinees and instructions given by 

proctor/invigilator 

  Note: Candidates are strongly advised to appear examination in smart casuals. 

Steps to Start Examination 

 

1. To download and install the examination software2.  
Note: Kindly uninstall the exam software installed for earlier examination session. While 

uninstalling the software, kindly ensure you delete the existing software folder from the 

local drive. You need to download and install the latest exam software. 

2. Close all the background applications, clear all cache, browser history, uninstall 

antivirus, screen sharing applications and disable windows firewall before 

accessing online exam platform.  

3. Ensure all notifications, pop-ups are closed/blocked before you start the 

examination to avoid the computer screen navigation away from the online 

examination window. 

4. You are advised to check your system compatibility before starting the 

examination. Click Here for Demo Video. 

5. Login to the exam platform 30 mins before exam start time using the link shared 

by IAI. (Do not share your examination link with anyone). 

6. In case if you face any technical issue kindly contact technical support number 

available on your examination screen/hall ticket. 

Note: If you are not provided with proper assistance within 10 mins from login time 

kindly email on exam@actuariesindia.org 

7. Click on Start Test. Click Here for Demo Video. 

8. Share your screen and allow access to microphone & camera. 

9. Read the software Instructions and click on “Next”. 

10. Read the Examination Instructions carefully and “Proceed”. 

11. Fill the mentioned details 

a. Member ID 

b. Roll number 

c. Name  

d. Email ID 

12. Click pictures of yourself and Government approved Photo ID using the web 

camera of the laptop/desktop and Submit for approval. In case the clicked 

picture is not properly visible then you will receive a prompt to capture the picture 

again. 

                                                           
2 We recommend that you should complete this step at least one week before the day of examination. 

https://drive.google.com/file/d/1szYOLpKOdBB2S90IXMD5mF7WGzuSfdRA/view?usp=sharing
mailto:exam@actuariesindia.org
https://drive.google.com/file/d/1pH-qQa5PLgGhEQiLEDRLYXhTBzrQjLLh/view?usp=sharing
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13. Profile verification will start 15 mins before the exam start time. You will be in queue 

till your profile gets verified. 

14. Proctor shall verify your hall ticket during the examination 

15. Read the Instructions 

16. Click on “Start Test” to start the examination. 

(Note: Your exam timer will start immediately after clicking the “Start Test” button and will 

end accordingly) 

 

Subject wise approach to write solution: 
 

Subject Approach to Write Solution 

CS & CM (Paper A) 

Open a new word document from the task bar of the exam 

platform and type solutions question wise and upload the same in 

exam platform 

CS (Paper B) 

Open a new word document from the task bar of the exam 

platform and copy & paste the R codes and output question wise 

and upload the same in exam platform 

CM (Paper B) 

Download the Solution Template (Excel) embedded within the 

question and then upload the worked solution template back to the 

exam platform 

CP2 
Open a new excel workbook from the task bar of the exam platform 

and upload the same in the exam platform. 

CP1 & CP3 To type solutions in Text Editor within the exam platform 

CB, SP, SA To type solutions in Text Editor within the exam platform 
Note: For CS, CM and CP2 (Paper A & B), it is advisable that the students utilise the last 15 minutes of the 

examination duration for uploading the answer script in the platform to avoid last minutes hassles. Only 

the last successfully uploaded answerscript in the exam platform will be considered for evaluation. 

Step for CS, CM (Paper A) 

 

- You can access MS-Word from taskbar in the exam platform. 

- You are advised to open a new word document from the task bar of exam platform 

with default file type (MS Office). 

- Save as the document only with your “Roll Number” e.g. CS1A2001 in your local 

drive and upload in exam platform once you have answered all the questions. 

- You are strongly advised to save your work in the MS Word Document in your local 

drive periodically till it is ready for upload in the exam platform in a timely manner. 

Note: Please be informed your working will not get auto saved in the exam platform.  

- The last successfully uploaded file by you will be considered as answerscript. 

- After submission you will receive a submission confirmation pop-up on the screen. 

Note: If you don’t get the submission pop-up, re-upload the file. 

 

Step for CM1B, CM2B, CP2A and CP2B: 

 

- You can access MS-Excel from taskbar in the exam platform. 
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- You will be provided with link to download the answer template within the 

question paper. 

- On clicking the link, you will get a dialog box showing two options  
 

a. Open File  

i. On clicking open file, the respective data file/solution template will 

open. 

ii. Click File option available on the top left corner of your screen and click 

on Save As option to the save the file in the local system with roll number. 

 

 

b. Save 

i. On clicking Save option the respective data file/solution template will 

automatically get downloaded in the default Download folder of your 

local system. 

ii. To access the file, click on the excel icon available on the bottom left 

corner of your screen. 

iii. On clicking icon, a new excel workbook will open on your screen. 

iv. Further click on the File Option available on the top left corner of your 

screen and then select the Open option. 

v. On clicking open, go to downloads folder of your local system to open 

the downloaded file. Please note that the while browsing the file type 

selection should be “All files”. 

- You are advised to open the downloaded file with default file type (MS Office). 

- Save as excel workbook with your “Roll Number” e.g. CM1B2001 in your local 

drive. 

- Write the solutions of respective question mentioned in excel and upload the file 

in the exam platform. 

- You are strongly advised to save your work in the MS Excel worksheet in your local 

drive periodically till it is ready for upload in the exam platform in a timely manner. 

 Note: Please be informed your working will not get auto saved in the exam platform.  

- The last successfully uploaded file by you will be considered as answerscript. 

- After submission you will receive a submission confirmation pop-up on the screen.  

 Note: If you don’t get the submission pop-up, re-upload the file. 

 

Step for CS1B and CS2B: (Click here to view of Demo Video) 

 

- You can access R/R Studio of available in your system from examination platform. 

Note: R Studio must be installed in following path C:\Program Files (i.e. default 

windows drive). If the Secure Exam Browser is unable to locate the .exe file, you 

can connect to the .exe file by browsing to the saved location. 

- You are advised to open a new word document from the task bar of exam 

platform with default file type (MS Office). 

https://drive.google.com/file/d/1CfswmsA5pju0EBSEidkAxu8Jtq323C1Q/view?usp=sharing
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- You can write the respective codes in R and copy the R codes & output and paste 

to MS Word document question wise. Save as the document only with your “Roll 

Number” e.g. CS1B2001 in your local drive and upload in exam platform. 

- You can access “R”, MS-Excel & MS-Word from taskbar in the exam platform. 

- You will be provided with link to download the dataset (if any) within the question 

paper. 

- On clicking the link, you will get a dialog box showing two options  
 

a. Open File  

i. On clicking open file, the respective data file/solution template will 

open. 

ii. Click File option available on the top left corner of your screen and click 

on Save As option to the save the file in the local system with roll number. 

b. Save 

i. On clicking Save option the respective data file/solution template will 

automatically get downloaded in the default Download folder of your 

local system. 

ii. To access the file, click on the excel icon available on the bottom left 

corner of your screen. 

iii. On clicking icon, a new excel workbook will open on your screen. 

iv. Further click on the File Option available on the top left corner of your 

screen and then select the Open option. 

v. On clicking open, go to downloads folder of your local system to open 

the downloaded file. Please note that the while browsing the file type 

selection should be “All files”. 

- You are strongly advised to save your work in the MS Word Document in your local 

drive periodically till it is ready for upload in the exam platform in a timely manner. 

Note: Please be informed your working will not get auto saved in the exam platform.  

- The last successfully uploaded file by you will be considered as answerscript. 

- After submission you will receive a submission confirmation pop-up on the screen.  

Note: If you don’t get the submission pop-up, re-upload the file. 

 

Steps for CB, CP1, CP3, SP and SA 

- You can type the solution within the text editor of the exam platform. 

- The equations can be inserted using the equation editor available in the exam 

platform wherever required. 

- For text editor based examination do not press Ctrl+Z shortcut key at any point 

during the examination.  

- Kindly navigate the questions appropriately, ensure you do not click on “All 

questions” button available on top right of the exam window. You can also 

navigate using “Prev Question” and “Next Question” buttons available on bottom 

right of exam platform. 

- Your work on the text editor within the examination platform gets auto-saved 

every after 90 seconds. 
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- You will not have access to any other application, document or file. 

 

Note:  

1. For CS, CM and CP2 (Paper A & B), it is advisable that the students utilise the last 

15 minutes of the examination duration for uploading the answer script in the 

platform to avoid last minutes hassles.  

2. If you upload excel workbook/word document with filename which is not as 

per IAI instructions, then it shall not be considered for evaluation. You are 

advise to memorise the file location that you will upload in the Exam Platform 

3. If there is no file upload submission pop-up on the screen, re-upload the excel 

worksheet/ word document.  

4. If you fail to upload excel workbook/word document before the exam end 

time, it will not be considered by any other modes. We strongly advise you to 

upload the workbook/word document in specified timelines. 

5. Files shared via Email will not be accepted, all files must be uploaded for 

submission via the examination platform only.  

6. Any uploaded Excel workbook/word document found to be modified outside 

the exam time will be investigated and may not be marked. 

7. Ensure uploaded excel workbook/word document is not password protected, 

if it is password protected the script will not be considered for marking. 

8. Any submitted excel workbook/word document should not contain any links 

to other documents. All Calculation should be present in submitted file only. 

9. The minimum software version requirement for MS Office and R based 

examinations are provided earlier in the Technical Requirements 

Please take note of the following: 

- You can use any standard function available in Excel, Word and R 

(excluding the use of Macros). 

- You can use the Equation Editor to construct any actuarial 

notation/symbol/equation. Alternately, you can use any other form of 

presentation of the same as long as any third person can comprehend what 

is written. 

- You are not permitted to handwrite mathematical equations. This includes 

the use of freehand drawing tools or other hardware such as drawing 

tablets, which are prohibited. 

- You are prohibited to use ‘Dictate’ or any similar function. You are expected 

to complete all examination answers using keyboard entry into the 

applicable platform as outlined earlier (To view Click Here). 

- You are requested to delete or disable any customized add-ins within the 

MS Office platform as its use or access is prohibited during the examination 

session. 

- You are prohibited to use RMarkdown and knitR during the R-based 

examination. 

 

Proctoring/Invigilation 
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- Each and every activity will be observed, monitored and recorded by the 

proctor/invigilator during the Examination. 

- Proctor/invigilator are trained to detect every malpractices happening during 

the online exam. 

- Proctor/invigilator can warn you for any malpractices came to notice. 

- Proctors/invigilators may pause/terminate your examination at any time for any 

malpractices observed. 

 

     Note: Proctor/Invigilator is only for supervision, in case of technical help, Kindly     

contact the helpline number available on the Examination platform. In case you are 

not able to reach the helpline number kindly contact Institute immediately. 

 

Technical Issue/ Internet failure/ Electricity failure 

- You are strongly advised to keep alternate arrangement for 

software/hardware/internet/electricity failure arise day before or on the exam 

day/during the examination. 

- No extra time/additional batch shall be granted for any software/hardware 

failures faced during the examinations. 
 

Post-Examination 

- Post completion of exam you need to submit the survey shared via email by IAI. 

- Survey will be available for 24 hours from the exam end time. 

- The Students are advised to email at exam@actuariesindia.org for the issues 

relating to the examination. Queries which are received within 2 days of 

completion of examination will only be entertained. 

 

 

****************** 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

mailto:exam@actuariesindia.org
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Annexure A 

FAQ’s – Actuarial Home Based Online Examination 

1. Why the Institute is conducting Actuarial examination in home based online 

mode? 
Due to prevailing COVID19 pandemic, it is not possible to access physical examination 

centers and operate a pen-and-paper examination. Keeping in mind the safety and 

security of our members, the Institute has decided to conduct the upcoming actuarial 

examination in a home-based online format. 

 

2. How will the Home-Based Online Examinations operate? 
The examination will be conducted within a secured browser environment where students 

will have access to the questions as well as medium to provide answers. All answers must 

be typed in and there will be no provision of submission of handwritten and scanned 

answer scripts.  

 

For subjects where R-Studio, MS Word and/or MS Excel software is required, such 

application can be accessed within the platform itself. 

 

This secured environment will be invigilated through online live proctors.  

 

 

3. What are the minimum software and hardware requirement to appear for Home 

Based Online Examinations? 
The following are the minimum software and hardware requirements to appear online 

Actuarial Examinations.  

Hardware 

Personal Desktop/ Laptop3 

Web Camera 

Microphone 

Operating System 

Licensed Windows 7 and above 

(NOTE: IOS / MAC BOOK ARE NOT ALLOWED) 

.NET Framework 4.5.1 and above 

Web Browser 

(Any One) 

Google Chrome – Ver. 63 and above (Recommended) 

Firefox -Ver. 52 and above (Recommended) 

Internet Minimum speed of 512 Kbps, preferred 1 Mbps and 

above 
Note: Use of mobile hotspot may lead to unstable internet connectivity. 

RAM Minimum 512 Mb, preferred 1-2 GB 

Note: Device should have free space of more than 65MB on the default hard drive 

 

For the following subjects, applicants shall also fulfil the additional requirements as given 

below:  

1. CM1, CM2, CP2:  

                                                           
3 No tablet or mobile devices are eligible 
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a. MS Office (Licensed) - 2010 or above  

Note: To preserve the integrity and security of the examination process and content. 

Functional Keys, Escape key and right click of the mouse will be disabled during the time of 

examination. Refer FAQ Question 53. 

2. CS1, CS2:  

a. MS Office (Licensed) - 2010 or above  

b. R version 3.6.1 or higher  

c. R Studio – Version 1.1 or higher for 32 bit operating system  

           Version 1.2 or higher for 64 bit operating system  

d. Packages – base, stats, utils, graphics, fpp, markov chain, forecast, dplyr, readxl, 

psych, corrplot, flexsurv, survival, etc. 

We expect the students to ensure that they are able to meet the above requirements 

before the mock test.  

4. How do I check my system compatibility before appearing actual examination? 
 

Click on below link to check the system compatibility: 

https://tests.mettl.com/system-check?i=2f9r3z1ukg#/systemCheck 
 

5. Is the examination platform capable of supporting the load expected basis 

number of students registered? 
We have entered a contractual agreement with a reputed third-party vendor who will 

provide the support for the online examination platform. We have taken steps to gain 

comfort that the examination platform can handle more than usual size of individual 

examination cohort that has registered in any previous session. 

 

6. Is there any risk of examination misconduct by students while writing examinations 

online? 
The Institute is conscious of enhanced perceived risk of misconduct in a situation where 

the examination will be held online and taken from home/any personal space.  To mitigate 

the risk, following are the steps taken to maintain the integrity of the actuarial examinations: 

 All examinations will be invigilated through online proctors who will have access to the 

candidates live and will be able to see and hear them. The proctors will be adequately 

empowered to take corrective and/or preventive steps should any misdemeanor is 

detected during the examination session. 

 It will be mandatory for the candidates to keep the webcam and sound 

card/microphone switched on for the entire duration of the examination session. 

 The candidates are advised to appear from a closed room with no one else being 

present in the same confined space. 

 The candidates will be prohibited from having access to any material offline in physical 

format or online on their personal devices or accessible through internet. 

 

The candidates are reminded that they are governed by Instruction to Examinees and the 

Institute reserves the right of taking appropriate and proportionate action should any 

misconduct comes to its notice during or after the examination session. 

 

7. Will there be a change in structure of question paper? 
Yes, a part of the question paper (up to 40%) will be set as MCQ format for CS and CM 

Paper A. This is done to mitigate challenges that may arise in typing complex actuarial 

notations during the examination session. However, please note that the students may still 

https://tests.mettl.com/system-check?i=2f9r3z1ukg#/systemCheck
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be required to type in some actuarial notation/ formula/ equation as required basis the 

question asked for these subjects. 

No changes are expected in any other subjects. 

 

8. What is the duration of the examination? 
Each paper of the Home-Based Online Examination will be 3 hours and 30 minutes long, 

except for CS1B, CS2B, CM1B & CM2B each of which will be 2 hours long. The students will 

be allowed to write for the entire duration of the examination. 

  

For CS, CM and CP2 (Paper A & B), it is advisable that the students utilise the last 15 minutes 

for uploading the answer script in the platform to avoid last minutes hassles. Failure to 

upload the answer script in time will mean that only the last uploaded version will be used 

for evaluation. In absence of any written and valid upload, it will be considered as NIL 

submission by the student.  

 

9. Is there any different study material/syllabus available for Home Based Online 

Examination? 
No. The syllabus and core reading for all subject’s remains the same as published on the 

Institute website, and thus the study material for 2022 examinations remain unchanged. For 

any clarification, contact Ms. Nilima at nilima@actuariesindia.org  

 

10. Is this Examination an Open-Book since format changed to home-based online 

format? 
No, this is a usual closed book Examination like how it is conducted if taken as a pen-and-

paper format in an Institute authorized physical examination centre. Accordingly, you are 

not allowed to bring any book/Study Material/ Notes or other items containing the content 

of the actuarial subject. Please note, you will be monitored by online proctors throughout 

the Examination.   

 

11. Will the marking or pass mark be changed given it is home based online format? 
No, our examiners have developed question papers suitable to be examined in an online 

format. We therefore are not planning to change the marking approach nor move the 

pass mark for this reason only. 

 

12. Can I use my Actuarial Table for online examination? 

- You can have access to your own actuarial tables. The book should not contain any 

annotation or markings whatsoever or any pre-written loose sheets attached to it. You 

may be asked to show and validate the same to the proctor during the examination.. 

(Note: Print or xerox copy is not allowed) 

 

13. Can I use an External Calculator from approved list of IAI during online 

examination? 
Yes, you can use scientific calculators during the examination. However, they can use only 

one of the models from the list below: 

i. Casio FX82 (ES/MS) (with or without any suffix) 

ii. Casio FX83 (ES/MS) (with or without any suffix) 

iii. Casio FX85 (ES/MS) (with or without any suffix) 

mailto:nilima@actuariesindia.org
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iv. Sharp EL531 (with or without any suffix) 

v. Texas Instruments BA II Plus (with or without any suffix) 

vi. Texas Instruments TI - 30 Plus (with or without any suffix) 

vii. Hewlett Packard HP12c (with or without any suffix) 

 

Please note that you will not be allowed to use any other model of the calculator. From 

this list, Casio FX82 (ES/MS), Texas Instruments BA II Plus and Texas Instruments TI-30 are 

available in India. They can be bought from any offline shop or ordered online from 

shopping portal. 
 

You may be asked to show and validate the same to the proctor during the examination. 

 

14. Will I be allowed more time to complete my examination given it is in online 

format? 
We recognize the change in examination format and concerns that well-prepared 

candidates may have on their ability to complete the examination in time given their 

typing speed. Therefore, we have adjusted the examination duration for all sessions to 

address such concern to the extent possible and you will notice that the examination time 

allowed for the upcoming session is higher than usual offline examination conducted 

earlier.  

 

15. How we will write the solutions or responses of the questions? 
Below is the subject wise approach to write the solution 
 

Subject Approach to Write Solution 

CS & CM (Paper A) 
To type answers question wise in MS Word Document and upload 

in exam platform 

CS (Paper B) 
To copy & paste the R codes and output in MS Word document 

and upload in exam platform 

CM (Paper B) 

Download the Solution Template (Excel) embedded within the 

question and then upload the worked solution template back to 

the exam platform 

CP2 

Download the Solution Template (Excel) embedded within the 

question and then upload the worked solution template back to 

the exam platform 

CP1 & CP3 To type answers in Text Editor within the exam platform 

CB, SP, SA To type answers in Text Editor within the exam platform 
Note: For CS, CM and CP2 (Paper A & B), it is advisable that the students utilise the last 15 minutes of 

the examination duration for uploading the answer script in the platform to avoid last minutes hassles. 

Only the last successfully uploaded answerscript in the exam platform will be considered for 

evaluation. 

16. Is there any specific font or size, I require to consider at the time of answering 

through online mode? Can I use bold/ italic and color font in my answer scripts? 
It is suggested to use default font size. 

 

17. How will I submit my answers? 
All answers to the examination can only be submitted in the examination platform. You 

can submit the answers any time after the start of the examination and before the end 

time of the examination. However, you would not be allowed to submit the answers under 
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any circumstance after the end time of the examination.  There is no provision of emailing 

or submitting your work by any other means. 

 

18. What functionalities of MS Office and R can be used during the CS, CM and CP2 

examinations? 
The minimum software version requirement for MS Office and R based examinations are 

provided earlier in answer to point 3. 

 

Please take note of the following: 

 You can use any standard function available in Excel, Word and R (excluding the use 

of Macros). 

 You can use the Equation Editor to construct any actuarial notation/symbol/equation. 

Alternately, you can use any other form of presentation of the same as long as any 

third person can comprehend what is written. 

 You are not permitted to handwrite mathematical equations. This includes the use of 

freehand drawing tools or other hardware such as drawing tablets, which are 

prohibited. 

 You are prohibited to use ‘Dictate’ or any similar function. You are expected to 

complete all examination answers using keyboard entry into the applicable platform 

as outlined earlier (see point 15). 

 You are requested to delete or disable any customized add-ins within the MS Office 

platform as its use or access is prohibited during the examination session. 

 You are prohibited to use RMarkdown and knitR during the R-based examination. 

  

19. Is it permitted to use a device that converts handwritten text into typed text 

automatically? 
No, you are not permitted access to such a device.  You are expected to complete all 

examination answers using keyboard entry into the applicable platform as outlined earlier 

(see point 15). 

 

20. What if I do not fulfil the mentioned software and hardware requirements to appear 

for online examination? 
You are strongly advised to ensure that you can fulfil the mentioned software and 

hardware requirements before the examination. In case if you do not, you will find that you 

are not be able to access the online platform during the examination and you will lose the 

attempt. 

 

21. Can I appear for online examination through my office laptop? 
You are advised to use your personal laptop/desktop for online examination. Office 

laptop/desktop may have security/download related restrictions. It is the candidate’s 

personal responsibility to ensure they meet the software and hardware requirements as 

stipulated above so that the online examination platform can operate without any 

hindrance. 

 

22. What happens if the computer hardware or MS Office/R software fails during the 

examination? 
You are strongly advised to test the hardware i.e. laptop or desktop along with accessories 

like mouse, keyboard, webcam, soundcard/microphone and satisfy yourselves that they 

are in working condition. You should have downloaded any latest security patches and 
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keep your device updated to its latest expected version before the start of the 

examination. You can also access any back-up device which meets the minimum 

hardware requirement as a replacement if need arises.  

 

In case of MS Office/R, we strongly advise the candidate to only use authorized and 

legitimate version of the software. The candidate is advised to download and install all 

latest software updates before the examination.  

 

Given this is home-based examination, it remains the responsibility of the candidate to 

ensure the hardware/software works during the time of examination.  

 

23. What happens in case of power failure/interruption during the examination? 
You are advised to keep your laptop fully charged and/or have a battery capacity that 

can last the full duration of an examination session. For desktop, it is advisable to have 

power back-ups which can be invoked in case of power failure/interruption.  

 

Given this is home-based examination, it remains the responsibility of the candidate to 

ensure the access to uninterrupted electricity or means to keep your device working.  

 

 

24. What happens in case if internet connectively fails during the examination? 
This is a home-based online examination which requires you to access an online platform 

over the internet during the entire duration of the examination, thereby ensuring that you 

can look up the question at any time and any answer written on the text editor within the 

platform gets auto-saved. You are invigilated through online proctors and the assigned 

proctors need to be able to see and hear you continuously during the entire examination. 

Both of these requirements mean that you need to ensure uninterrupted internal 

connectivity during the examination session. 

 

In case of unfortunate situation when internet connectivity does get disrupted 

intermittently, the following needs to be kept in mind: 

 Your work on the text editor within the examination platform gets auto-saved frequently 

and chances of losing any written work are remote. 

 Your work done on MS Office or R software doesn’t get automatically saved in the 

platform till you upload the relevant files at the end.  You should therefore ensure you 

are saving the work in your local drive periodically till it is ready for upload to avoid 

disappointment. 

 You are expected to keep screenshots as evidence for any internet disruption 

impacting your work materially as and when they occur. You may be asked to submit 

them in case you are seeking relief due to such disruption. 

 Any deliberate attempt to disconnect the internet access will be considered as 

misconduct and disciplinary action can be initiated under such circumstances.  

 

You are advised to keep provision of alternate internet connection which can help in 

minimizing disruption. 

 

25. Is there a way I can apply for mitigating circumstances in case of prolonged 

disruption caused by hardware/software failure, or issues related to electricity or 

internet connectivity? 
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You are advised to keep provision for alternate options to mitigate issues related to above 

mentioned disruptions. The Institute unfortunately will have no recourse to help/fix in case 

of any failure before or during the examination.  

 

We have updated the examination duration for this session to allow for such incidences, 

thereby allowing candidates fair chance to complete the paper in time. In case of 

disruption such that it adversely impacted your performance materially, the impacted 

candidate is advised to write to the Institute after the end of examination session seeking 

appropriate recourse along with evidence. The Institute will look at the request basis its 

merits. 

 

26. What happens if the examination platform fails during the examination? 
In an unfortunate situation where the examination platform fails for reasons other than 

issues related to candidate’s hardware/software or power/internet connectivity, the 

Institute will try to put alternate arrangements in place on a best effort basis. In case it is 

not possible, the Institute may offer to re-schedule to an alternate date or cancel the 

session/provide refund of examination fees as deemed appropriate. 

  

 

27. Is there a provision for me to see/test the examination platform beforehand? 
We recognize that you will be using this online examination platform for the first time. To 

ensure that platform works on your individual device as expected and give you a hands-

on experience of using the platform before the examination day, we have planned to 

conduct mock test/s in the weeks prior to examination start date.  

 

We strongly advise all registered candidates to appear for such test and use the 

opportunity to test the application on your personal devices and experience how the 

online platform would work on the day of examination. Please note we are not going to 

mark the scripts submitted during the mock test.   

 

28. Where should I take the examination? 
This is a home-based online examination. We would suggest that you appear for the 

examination in any place at home, or any private place, keeping the following in mind: 

 The place should be quiet and you can keep access for the full duration of the 

examination without an external interference. 

 It should be a confined private place where you can control access from anyone else 

entering without permission. 

 You are required to ensure that no one else can be present during any part of the 

examination session 

 You have access to electricity and internet connection. 

 It should be well lit so that the online proctor can see you at all times. 

 You are advised that you have a comfortable chair to sit and a desk to keep your 

personal device and write. 

 

29. What can I keep with myself during the examination?  
The following are permitted to be kept with you during the examination session: 
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 One Personal device i.e. laptop/desktop with webcam along with other accessories 

like keyboard, mouse, laptop charger etc. as per the requirement as mentioned under 

point 3 above 

 Actuarial tables 

 Scientific calculator 

 Loose sheets of blank paper for rough work. You are required to show these before 

using by the proctor. 

 Pen/Pencil to write on loose sheets 

 Any government-issued ID to be used for verification 

 Bottle/glass of water 

 Back-up hardware  
Any form of personal consumables, mobile phone, smart watch, handsfree device, 

headset/ earphones etc. or any other electronic gadget are not allowed to be kept near 

you during the examination. 

 

30. Do I need to arrange any invigilator for my home-based online examination? 
No 

 

31. What if Government approved ID card and hall ticket are not available with me at 

the time of Examination? 
You will not be allowed to appear for examination, in case you fail to do so you may lose 

the attempt. 

 

32. Can I request for a change to my examination start time? 
No, the examinations will be strictly held as per the Exam Time Table. 

 

33. Can I appear form online examination outside India? 
All exams are scheduled in Indian Standard Time (IST) 

Click here to view Announcement of Actuarial Examination 

34. Will there be an invigilator to monitor the examination? 
Yes, there will be an online proctor monitoring each of your activity throughout the 

examination. The proctor will be adequately empowered to act on any misdemeanours 

or advice candidates on appropriate behaviour from time to time.  

 

35. When will I receive the Examination login credentials and Exam Instructions? 
You will receive the login credentials and exam instructions 2 days before the Examination 

Date. 

 

36. Can I move from system during Examination? 
No, you are not allowed to move away from the system during examination. In case you 

need a comfort break, you are allowed with due permission taken from and only for 

specific time as advised by the proctor. 

 

37. Is there a Policy for Differently Abled Candidates related to the Examination? 
Yes, we have a policy on this matter. Kindly refer the below link: 

http://www.actuariesindia.org/downloads/PolicyforPHCandidates1.pdf  

 

http://www.actuariesindia.org/downloads/Announcement%20for%20March%202022%20Actuarial%20Exam%20Registration.pdf
http://www.actuariesindia.org/downloads/PolicyforPHCandidates1.pdf
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38. Will I be able to login and take the examination after the start time? 
Candidates who log in late after the start time of the examination will not be allowed to 

access the platform and write the examination.  

 

39. Who do I contact for general enquiries (if any) not covered by above FAQs in this 

regard prior to Registration /Examination? 
Please contact exam@actuariesindia.org  

 

40. Who do I contact for technical issue (if any) during the Examination? 
Please contact to the helpline numbers available on the Examination platform. In case you 

are not able to reach them, kindly email on exam@actuariesindia.org for immediate 

assistance. 

 

41. I am unable to install Mettl Secure Browser in my system. How to trouble shoot issue 

while launching MSB during exam? 
You are advised to go through below links: 

https://support.mettl.com/portal/en/kb/articles/faq  

https://support.mettl.com/portal/en/kb/articles/attempting-a-proctored-test-in-msb 

https://support.mettl.com/portal/en/kb/articles/mettl-secure-browser-msb 

 

42. How do I check my web camera and microphone compatibility before appearing 

actual examination? 
Please follow the below steps: 

 

  Close all the applications which might be using Camera and Microphone. 

 Open the OS "C: drive"of the Windows. 

 Open Program Files(X86) folder or Program Files. 

 Open the Mettl Folder 

 Open MSB Folder in the Mettl Folder. 

 In the MSB Folder, Open the SebWindowsBrowser folder. 

 Open the xulrunner folder in the SebWindowsBrowser folder. 

 Open Firefox from the xulrunner folder. 

 Once the Firefox is Open, in the address bar type https://webcammictest.com 

 You will be asked to give permission for Camera and Microphone. 

 

 

43. How to re-login after facing the technical issue? 
Click on power button located on bottom right side of the screen. Re-login using the same 

examination link after 5-7 minutes. 

 

44. What if my login window keeps loading and not proceeding further? 
Please try the following. 

 Check Internet Connectivity or Exit Browser(click on power button on bottom right of 

exam screen) 

 Re-install the MSB it and try to launch examination again. 

 Hard Shutdown (shut down your system by pressing power button for 5-10 seconds) 

 

45. What if my web camera/microphone is not detected in between an ongoing 

examination? 

mailto:exam@actuariesindia.org
mailto:exam@actuariesindia.org
https://support.mettl.com/portal/en/kb/articles/faq
https://support.mettl.com/portal/en/kb/articles/attempting-a-proctored-test-in-msb
https://support.mettl.com/portal/en/kb/articles/mettl-secure-browser-msb
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There are no permission issues for Camera and Microphone within MSB. If you are facing 

issues, it may be because of 

 Camera or Microphone are not in working condition. 

 Appropriate resolution from the Camera is not available. 

 Any other hardware issues. 

 Any Third-party app is using Camera or Microphone. 

 

To check the Camera and Microphone working condition follow below mentioned 

steps. 

 Close all the applications which might be using Camera and Microphone. 

 Open the OS "C: drive" of the Windows. 

 Open Program Files(X86) folder or Program Files. 

 Open the Mettl Folder 
 Open MSB Folder in the Mettl Folder. 

 In the MSB Folder, Open the SebWindowsBrowser folder. 

 Open the xulrunner folder in the SebWindowsBrowser folder. 

 Open Firefox from the xulrunner folder. 

 Once the Firefox is Open, in the address bar type https://webcammictest.com  

 You will be asked to give permission for Camera and Microphone. 

 If the Camera and Microphone are in working condition, then there will be a screen 

as below with your image. 

 

 

 

46. How to access "R Studio" for CS Paper B Subjects during examination? 
Candidate needs to install the below mentioned software’s in their system in the Local 

Drive C:\Program Files\ 
 

 R version 3.6.1 or higher  

 R Studio – Version 1.1 or higher for 32-bit operating system Version 1.2 or higher for 64-

bit operating system  
 

Once you have started MSB you will get a notification pop up to search for R studio 

application. The default path is C:\Program Files\RStudio\bin unless you have saved the 

file somewhere else in which case you would need to search that directory accordingly 
 

https://webcammictest.com/
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Click here to view Demo Video 
 

Once you have located the file please click on Rstudio.exe file (within bin folder by 

default). You will be able to see three applications that you are allowed to use in the exam. 

If R Studio is not seen here please follow the process above again as otherwise the 

examination wont start till this is fixed.  

 

47. How can I copy/paste codes and output from R Studio to MS Word? 
Type the codes and Output in “R Studio” and simply copy the content using Ctrl + C and 

to paste using Ctrl + V in MS Word document. In case Ctrl + V is not responding, try pasting 

by clicking the Paste  Paste Special  Values option under Home tab within the 

Command Bar in MS Word application. 

 

48. How to access "Excel" or "Word" application during examination? 
Candidate needs to have licensed version of MS Office 2010 and above installed in their 

system in the Local Drive C:\Program Files\ 
 

Mettl Secure Browser will automatically detect the above application and the same can 

be accessed from the task bar below within the examination window. 

 

Note:  

 Candidates are advised to update the following settings in the MS Word and MS Excel 

before      

starting the examination: Open Any Word/Excel document available in your system 

then go to Files  Options  Trust Center  Trust Center Settings  Protected View  

(Uncheck all the 3 options)  Click on OK. 

 

 Candidate are required to close all the MS Office applications at the background 

before starting the examination. 

 

49. How to toggle between the Examination Window and MS Word/Excel during the 

examination? 
You can simply use ALT+TAB to toggle between the Examination Window and MS Word/ 

MS Excel/ RStudio during the examination. This will work only after you have opened at 

least one more application other than main examination platform in MSB.  
      Note: This is only applicable for CS1, CS2, CM1, CM2 and CP2 Subjects 

 

50. I am unable to locate the downloaded solution template/data files provided in 

the question paper? (Applicable for CS, CM, CP2 subjects) 

You can access the downloaded solution template/data files using the following 

steps: 

i. Click on the excel icon available on the bottom left corner of your screen. 

ii. Go to File -> Open -> Browse Download Folder of your system. 

iii. Select the downloaded solution template/data file to open. 

 

51. I am unable to use escape key and right click with the mouse/touch pad during 

examination. 
To preserve the integrity and security of the examination process and content, the above 

features will not be available. These restrictions would however not expect to hamper your 

access to any permissible action during the examination, particularly which require use of 

MS Excel software. 

https://drive.google.com/file/d/1CfswmsA5pju0EBSEidkAxu8Jtq323C1Q/view?usp=sharing
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52. How to insert Equations/Symbols in solution typing area? 
You can insert equation in solution typing area using the equation editor available in the 

exam platform for all subjects except for CS Series, CM Series and CP2 Subject. 

 

Kindly refer following link; https://support.mettl.com/portal/en/kb/articles/how-to-

attempt-math-and-chemistry-type-questions-in-the-test 
 

53. I am unable to use the popular shortcut function keys like F2, F4, F9 and F11 during 

the examination. 
To preserve the integrity and security of the examination process and content, the 

examination platform restricts the use of any function keys, particularly during the 

examination which require use of MS Excel software. 

 

These function keys are meant to act as shortcuts to the standard functions in Excel which 

can still be accessed in the usual manner. We have tabulated below the alternate means 

to operate the some of the popular function keys in Excel during the examinations: 

 

54. Will there be questions in CB, CP1, CP3, SP and SA subjects that will require graphs 

and diagrams in the solution? 
Our examiners have aligned the question paper pattern where you will not have a 

mandatory requirement to use graphs/diagrams to support your answers. 

 

55. Do I expect to experience some lag in toggling between/using different 

applications during CS, CM and CP2 examinations? 
There can be many reasons why you could, at times, be experiencing lag while toggling 

between different applications. Mostly it can be due to number of applications open 

(including any program/software running at the background) at the same time, your 

hardware RAM and quality of internet connectivity. 

Function Key 

(func + <>) 
What it does? Direct approach 

F1 Opens Excel Help 
Click the Help tab to access help 

available in the top right of the screen 

F2 

Moves the insertion point to the 

end of the contents of the 

active cell 

Click the cell itself using mouse/touch 

pad 

F3 
Displays the Paste Name dialog 

box 

Type in the Named range in the cell 

itself  

F4 Cell references Type in “$”at appropriate stage 

F5 Displays the Go To dialog box 
Find Go To option by clicking Find & 

Select under Home tab 

F7 Displays the Spelling dialog box Click Spelling on the Review tab 

F9 Calculates the workbook 

Go to the Formulas tab, in the 

Calculation group, click Calculations 

Options 

F11 
Creates a chart sheet of a 

selected range 

Go to the Insert tab, click the Chart 

that you want to draw 

F12 
Brings up the Save As dialog 

box. 
Click Save Us Under File tab 

https://support.mettl.com/portal/en/kb/articles/how-to-attempt-math-and-chemistry-type-questions-in-the-test
https://support.mettl.com/portal/en/kb/articles/how-to-attempt-math-and-chemistry-type-questions-in-the-test


 
 

Student Guide for Actuarial Home Based Online Examination             Page 24 of 24 

 

 

The following guidance (though not exhaustive) can help: 

 It is advisable that you ensure all applications (including those run in the background 

like anti-virus software) are closed/shut before you commence your examination.  

 It will help if you are using a laptop/desktop with higher RAM capacity than minimum 

advised.  

 It will help if you delete all temp files from your system before you open the examination 

platform. 

 You can choose a place to write the examination close to your internet router so that 

you can get stable Wi-Fi connectivity. 
 

 

****************************** 


